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Tealeaf CX Mobile User Manual

Tealeaf® CX Mobile User Manual details the IBM Tealeaf CX Mobile module for the
IBM Tealeaf CX platform, which enables analysis and reporting on visitors who use
mobile devices to access your web application. Use these links to access specific
topics in the manual.
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Chapter 1. IBM Tealeaf CX Mobile

The IBM Tealeaf CX Mobile modules capture, replay, and analyze the experiences
of visitors who access your web application through web browsers or mobile
native applications on mobile devices. Through IBM Tealeaf CX Mobile, you can
monitor the mobile user experience with the same IBM Tealeaf suite of analysis
tools that are used for visitors on desktop systems.

As the mobile device installation base expands, gaining insight into this rapidly
developing market is critical to making more informed decisions about optimizing
your website for the mobile experience. Given the wide array of mobile devices in
use on the web, forward-thinking enterprises must be able to examine how to best
serve this diverse and growing customer segment. The IBM Tealeaf event-driven
capabilities segment mobile users for detailed reporting to meet your enterprise
requirements.

Information capture

The IBM Tealeaf CX Mobile for Mobile Application components capture
information from the mobile native applications that you deploy for your
customers. The captured information includes:
v User interface events
v Application events
v Mobile device properties

Developers can integrate the supported Logging Frameworks with their deployed
applications and enable the capture of this rich set of application data for use in
IBM Tealeaf.
v See “Integrate IBM Tealeaf CX Mobile with your mobile applications” on page 9.

Information about module

The IBM Tealeaf CX Mobile module is a separately licensed module of the IBM
Tealeaf CX platform. please contact your IBM Tealeaf representative.

The mobile user experience and the desktop user experience are not
the same

The mobile user's experience and expectations are fundamentally different from the
desktop browser user's experience and expectations.

Mobile users:
v Are task-oriented
v Want efficient and quick resolution of their transactions
v Are easily frustrated
v Have a more personal point of view with online interactions

The methods for monitoring customer struggle with Tealeaf provide unique insight
into areas where your mobile customers are getting frustrated and potentially
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abandoning transactions. By deploying IBM Tealeaf CX Mobile, you can monitor
mobile customer experience and processes with a fidelity not available in other
solutions.

Why use Tealeaf?
IBM Tealeaf CX Mobile delivers key information on the mobile user experience. In
addition to standard analytics capabilities in capturing user profiles and reporting
on time-based activities, the Tealeaf mobile solution provides insight into why
activities are happening.

Mobile user experience information

Tealeaf provides mobile user experience information that gives you:
v Visibility into mobile user success and failure:

– Detect obstacles or issues without relying on user feedback
– Understand usage by mobile devices across the user base, site, and apps
– Identify cause without having to update or relaunch services
– Visibility into usage patterns across the entire user base

v Accelerated time-to-market:
– Stop waiting on user feedback before you make improvements
– Rapidly evaluate mobile features: adoption, success, and failure points
– Eliminate poor quality to deliver winning mobile services

v Informed mobile investments:
– Quantify business impact to prioritize decisions: fix, invest, and remove
– See the actual usage of mobile services rather than the expected usage

Use the mobile user experience information

With the information that you collect with Tealeaf you can:
v Detect user struggle
v Drill down into visitor behavior to analyze individual sessions
v Correlate visitor behavior with network data

What IBM Tealeaf CX Mobile does
IBM Tealeaf CX Mobile captures web and application events, replays mobile
sessions, and collects visitor and device metrics.

Capture web and application events

IBM Tealeaf CX Mobile enables the monitoring and capture of client-side
interactions through mobile web browsers and native applications. These events
are captured transparently to the user and submitted to Tealeaf for capture and
processing through your installed Tealeaf solution.
v Device demographics can be captured through the user agent string that is

submitted by the device or the installed Tealeaf client framework that is used to
monitor the device

v Capture of exception messages for processing and rapid reporting
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Mobile session replay

IBM Tealeaf CX Mobile captures the complete set of interactions of every mobile
visitor. You can replay captured sessions in a browser-level recording through
Browser-Based Replay. Session replay for mobile devices accounts for browser
capabilities, screen sizes, and other characteristics of the device and its browser.
v Support for mobile-specific actions such as orientation change, swipe, and more
v Render in replay by using screen dimensions, known device characteristics, and

orientation
v For more information about search and replay for Mobile web, see Chapter 2,

“Search and Replay for mobile web sessions,” on page 11.
v For more information about search and replay for Mobile App, see Chapter 3,

“Search and Replay for Mobile Apps,” on page 21.
v For more information about Browser-Based Replay, see "CX Browser Based

Replay" in the IBM Tealeaf cxImpact User Manual.

Mobile visitor and device metrics

IBM Tealeaf CX Mobile enables detailed data capture on mobile visitors and their
devices. Usage statistics and trending patterns can be monitored through provided
reports. You can also create ad hoc visitor segments that are based on mobile
attributes such as device manufacturer, operating system, screen resolution, and
more.
v For more information about visitor segments, see "Analyzing Visitor Segments"

in the IBM Tealeaf cxResults User Manual.

Available Mobile Data by License
The available mobile data that is captured differs based on the Tealeaf product
licenses that you have.

This table lists and describes the data that is captured by Tealeaf licensed products:
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Table 1. Available Mobile Data by License

License Capability Description

IBM Tealeaf
cxImpact

Capture user agent data When extended user agent parsing is
enabled, IBM Tealeaf cxImpact can
capture data that is submitted with
each request by the visitor's user
agent. This data is inserted into the
request by the Tealeaf Reference
session agent, which uses a deployed
version of the browscap public
standard to look up more data. Part
of this data insertion is identifying
whether the session was initiated
from a mobile device or not.
Note: If you do not deployIBM
Tealeaf CX UI Capture j2, some
aspects of the mobile visitor
experience cannot be replayed. For
best results in displaying orientation
change, enabling resizing of the
replay view screen, you must deploy
UI Capture. See the IBM Tealeaf UI
Capture for j2 Guide.

v Extended user agent parsing is
enabled by default. See "Tealeaf
Reference Session Agent" in the
IBM Tealeaf CX Configuration
Manual.

v For more information about user
agents, see "Managing User
Agents" in the IBM Tealeaf cxImpact
Administration Manual.

IBM Tealeaf
CX license
(IBM Tealeaf
CX UI
Capture for
AJAX)
Note: IBM
Tealeaf CX
UI Capture
for AJAX is
only
available to
legacy
users.

Capture mobile device properties and
UI events (gesture, touch, and so on)

When the IBM Tealeaf CX license is
enabled, customers can deploy the
IBM Tealeaf CX UI Capture for AJAX
solution. This Javascript-based
solution is deployed from your web
servers to the visitor's browser. It
captures mobile-specific events, such
as gesture and touch events, as well
as mobile device properties.
Note: This license is not enforced in
the product and operates
independently of the other licenses. It
is managed through limited
distribution of the library.

v For more information about IBM
Tealeaf CX UI Capture for AJAX,
see "UI Capture FAQ" in the IBM
Tealeaf UI Capture for Ajax FAQ.

v For more information about
mobile-specific features of IBM
Tealeaf CX UI Capture for AJAX,
see "UI Capture for Ajax Reference"
in the IBM Tealeaf UI Capture for
Ajax Guide.
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Table 1. Available Mobile Data by License (continued)

License Capability Description

IBM Tealeaf
CX license
(IBM Tealeaf
CX UI
Capture for
AJAX)

Capture mobile device properties and
UI events (gesture, touch, and so on)

When the IBM Tealeaf CX license is
enabled, customers can deploy the
IBM Tealeaf CX UI Capture for AJAX
solution. This Javascript-based
solution is deployed from your web
servers to the visitor's browser. It
captures mobile-specific events, such
as gesture and touch events, as well
as mobile device properties.
Note: This license is not enforced in
the product and operates
independently of the other licenses. It
is managed through limited
distribution of the library.

v For more information about IBM
Tealeaf CX UI Capture for AJAX,
see "UI Capture FAQ" in the IBM
Tealeaf UI Capture for Ajax FAQ.

v For more information about
mobile-specific features of IBM
Tealeaf CX UI Capture for AJAX,
see "UI Capture for Ajax Reference"
in the IBM Tealeaf UI Capture for
Ajax Guide.

IBM Tealeaf
CX license
(IBM Tealeaf
CX UI
Capture j2)

Capture mobile device properties and
UI events (gesture, touch, and so on)

When the IBM Tealeaf CX license is
enabled, customers can deploy the
IBM Tealeaf CX UI Capture j2
solution. This Javascript-based
solution is deployed from your web
servers to the visitor's browser. It
captures mobile-specific events, such
as gesture and touch events, as well
as mobile device properties.
Note: This license is not enforced in
the product and operates
independently of the other licenses. It
is managed through limited
distribution of the library.

v For more information about IBM
Tealeaf CX UI Capture j2, see the
IBM Tealeaf UI Capture for j2 Guide.
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Table 1. Available Mobile Data by License (continued)

License Capability Description

IBM Tealeaf
CX Mobile
module

Capture mobile user agent data When the IBM Tealeaf CX Mobile
module is licensed, the Tealeaf
Reference session agent can perform
more mobile-specific lookups for user
agent information by using the
WURFL public standard. This
standard contains detailed data on
known mobile devices, which are
based upon the user agent string that
is submitted in the request.

v IBM Tealeaf CX Mobile requires
the XML version of the WURFL
standard to be converted to an
internally usable CSV format. If the
IBM Tealeaf CX Mobile module is
not licensed, access to the utility
provided by Tealeaf to perform this
conversion is forbidden. For more
information about WURFL and this
utility, see "Overview of User
Agents for CX Mobile" in the IBM
Tealeaf CX Mobile Administration
Manual.

IBM Tealeaf
CX Mobile
module

Replay of mobile user agent data,
device properties, and UI events

When IBM Tealeaf CX Mobile is
licensed, the replay of mobile-sourced
sessions is supported in
Browser-Based Replay (BBR).
Note: When IBM Tealeaf CX Mobile
module is not licensed, the following
limitations are applied to replay of
mobile-based sessions:

1. No display of mobile-specific
events, such as scroll and touch

2. No display of mobile device data
during replay

3. No use of a mobile skin
(Extended user agent parsing is
also required.)

4. No display of device orientation
changes

5. No resizing of the screen to the
mobile browser dimensions

The underlying data is captured
independent of the license; enabling
the license allows mobile-based
replay of sessions that are already
captured.

v BBR is a Portal-based method of
replaying sessions. For more
information about BBR replay, see
"CX Browser Based Replay" in the
IBM Tealeaf cxImpact User Manual.
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Table 1. Available Mobile Data by License (continued)

License Capability Description

IBM Tealeaf
CX Mobile
for Mobile
App

Capture of native app events for iOS
and Android systems

When IBM Tealeaf CX Mobile is
licensed, customers can request access
to the iOS and Android Logging
Frameworks. When these frameworks
are deployed as part of the native
applications that you build and
deploy to your visitors by using iOS
and Android devices, a large set of
device properties and application
events are captured and submitted to
Tealeaf for processing, enabling close
monitoring of device-specific
activities.
Note: This license is not enforced in
the product and operates
independently of the other licenses. It
is managed through limited
distribution of the library.

v See the IBM Tealeaf iOS Logging
Framework Guide.

v See the IBM Tealeaf Android Logging
Framework Guide.

Where to look for information
IBM Tealeaf CX Mobile is pre-configured to analyze on sessions that are captured
from visitors by using mobile devices.

To meet the requirements of your enterprise, review this configuration and
documentation reference information:

Capability Description Documentation

Reference data Tealeaf can identify mobile
devices that are based on the
device type or browser type.
Additionally, Tealeaf can
monitor specific features of
the device, such as video
streaming, picture display,
and JavaScript capabilities.

v If your UI Capture is
licensed and deployed to
track user interface events,
events specific to mobile
device browsers can be
captured and processed by
Tealeaf.

v See "Configuring Tealeaf
for Mobile Visitors" in the
IBM Tealeaf CX Mobile
Administration Manual.

WURFL Tealeaf relies on a publicly
available standard for
identifying mobile devices.
This standard requires
regular updating from the
source.

See "Configuring Tealeaf for
Mobile Visitors" in the IBM
Tealeaf CX Mobile
Administration Manual.
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Capability Description Documentation

Creating events Based on the captured user
agent data, you can create
events that can be used to
identify mobile visitor
activities and device
capabilities. Based on these
events, you can create alerts
and reports for display in the
Portal.

See Chapter 4, “Events for
mobile visitors,” on page 33.

Reports on mobile visitors
and devices

As needed, you can
download report templates
or create custom reports to
surface information about the
mobile visitor experience.

See Chapter 5, “Generate
reports for Mobile web,” on
page 57.

Mobile Web Replay Segments from mobile
visitors and devices can be
replayed through
Browser-Based Replay in the
Tealeaf Portal. Browser-Based
Replay can be configured to
replay the visitor session at
the appropriate screen size
for the device in use and to
indicate user interface events.

See Chapter 2, “Search and
Replay for mobile web
sessions,” on page 11.

Mobile App Replay Sessions can be replayed as
screen captures or as an
HTML representation of the
native mobile session with
information related to
multiple screens. You can
replay mobile app sessions in
Browser Based Replay.

See Chapter 3, “Search and
Replay for Mobile Apps,” on
page 21.

Enabling CX Mobile
There are several options to enable CX mobile. Some of the options involve
working with IBM Tealeaf CX, IBM Tealeaf cxView, and IBM Tealeaf cxImpact.

Get a license key
IBM Tealeaf CX Mobile is enabled through the license key that you enter in the
Tealeaf Installer at upgrade time. A new license key is required. Contact your IBM
Tealeaf representative.

Get the latest BrowsCap.csv
BrowsCap is a publicly maintained standard for identifying user agents on the
web. You must download and install the latest version of Browscap.csv into your
Tealeaf solution.
v See "Maintaining the CX System" in the IBM Tealeaf CX Installation Manual.

Get the latest WURFL.xml
WURFL is a publicly maintained standard for identifying mobile devices in use on
the web. You must download the latest version of WURFL.xml and convert to use in
your Tealeaf solution.
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v See "Maintaining the CX System" in the IBM Tealeaf CX Installation Manual.

Convert the latest WURFL.xml file to Tealeaf format
After you get the latest WURFL.xml file, you must convert it to a form that is usable
by your Tealeaf solution. Tealeaf provides an external tool to convert the
downloaded file.

Use the WURFL2csv.exe program to convert the WURFL.xml file into the required
format.
v See "User Agent Tools" in the IBM Tealeaf cxImpact Administration Manual.

Get mobile dashboards from IBM Tealeaf cxView
You can download and import mobile dashboards from IBM Tealeaf cxView to use
in CX Mobile.

Download mobile dashboards
Tealeaf published dashboards for IBM Tealeaf CX Mobile, which contain the event
definitions that are required to capture mobile data for aggregation into dashboard
reports.

Import mobile dashboards
Use the IBM Tealeaf cxView Report Manager to bring the mobile event reports and
dashboard that you downloaded into the system.
v See "Importing and Exporting Reports" in the IBM Tealeaf cxView User Manual.

Update the Event Values Lists with the latest User Agent data
Event Value Lists are used to display the different browser types, mobile devices,
and platforms. The UAValueListCreator.exe tool creates these values lists, which
you can then import to the system.
v See "User Agent Tools" in the IBM Tealeaf cxImpact Administration Manual.

Integrate IBM Tealeaf CX Mobile with your mobile applications
IBM Tealeaf CX Mobile for Mobile App includes a set of Logging Frameworks,
which are deployed by your developers with mobile native applications served to
your customers. The logging frameworks are used to capture and submit events to
IBM Tealeaf.

When deployed and enabled, the Tealeaf Logging Frameworks capture user
interface events, application events, and properties. The Tealeaf Logging
Frameworks submit the events and properties in batches to IBM Tealeaf for
capture. The information can be captured as a single screen capture or as an HTML
representation with information related to multiple screens. In this manner, you
can closely monitor a predefined set of events or customize your own events on
the application and how users interact with it.

Data that is submitted to Tealeaf is decoded in the Windows pipeline by using a
specialized session agent. The data is then available for search and reporting as
data inserted into the request.

IBM Tealeaf provides the following Logging Frameworks.
v See the IBM Tealeaf CX Mobile iOS Logging Framework Guide.
v See the IBM Tealeaf CX Mobile Android Logging Framework Guide.
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Chapter 2. Search and Replay for mobile web sessions

Like desktop browser sessions, Tealeaf mobile user sessions can be replayed
through Browser-Based Replay in the Portal.

Browser-Based Replay replays the visitor experience with your web application.
Screen size is adjusted to account for the smaller displays. JavaScript capabilities
are curtailed to match the capabilities of mobile device browsers. Other
characteristics of the mobile browser are also applied to the replay view in BBR.
v If UI Capture is deployed, orientation changes, scroll events, and other user

interface events are represented in replay. See “User interface events captured
from mobile browsers in BBR” on page 19.

Through mobile replay, Tealeaf users can identify problem areas in the web
application's presentation to visitors to improve it and resolve disputes.

Identify mobile web sessions from mobile devices
Tealeaf uses user agent information to identify sessions that are experienced with a
mobile browser. The user agent information is submitted in each request by the
browser to a web server. This capability is enabled by default for fixed user agents,
such as desktop browsers. For mobile devices, more configuration is required, and
a standard that is known as WURFL is used.

How the user agent information is used

When a hit is processed through the Canister, the Windows pipeline scans the
request for the user agent information. The user agent information is then matched
up against a public standard of known mobile devices.

If a match for the user agent is found in the WURFL standard, more information
about the device from WURFL is inserted into the request of each hit. This
information includes the screen resolution and JavaScript capabilities of the mobile
browser.

Example of [ExtendedUserAgent] section of a request

This information is inserted into the [ExtendedUserAgent] section of the request.

In this example, the TLT_TRAFFIC_TYPE=MOBILE name-value pair indicates that
Tealeaf Reference session agent is successfully matched the TLT_BROWSER against the
WURFL public standard for mobile user agents.
[ExtendedUserAgent]
TLT_BROWSER=Openwave Mobile Browser
TLT_BROWSER_VERSION=Openwave Mobile Browser6.2
TLT_BROWSER_PLATFORM=
TLT_TRAFFIC_TYPE=MOBILE
TLT_BROWSER_JAVASCRIPT=false
TLT_BROWSER_COOKIES=true
TLT_BRAND=LG
TLT_MODEL=LG MX510
TLT_SCREEN_HEIGHT=220
TLT_SCREEN_WIDTH=176

© Copyright IBM Corp. 1999, 2014 11



TLT_COLOR_DEPTH=65536
TLT_PICTURE_SUPPORT=true
TLT_VIDEO_SUPPORT=false
TLT_STREAMING_SUPPORT=false

Use the example code to search for mobile sessions

Using the [ExtendedUserAgent] section of the request, you can search for mobile
sessions. To improve search performance, create and use event objects through the
Tealeaf Event Manager to identify mobile visitors.

You can use the Traffic Type hit attribute and dimension to design a search for
mobile device sessions:
1. Tealeaf provides a Traffic Type hit attribute to scan the request for the value

of the TLT_TRAFFIC_TYPE variable name. For example, the value for this hit
attribute for the hit is MOBILE.

2. The hit attribute is used to populate the dimension Traffic Type, which can be
used as a criterion for an event search term. For example, you can search for
specific events where the Traffic Type dimension value is MOBILE. Searches of
this type return all sessions in which the event occurred when the Traffic Type
dimension indicated that it was a mobile session.

3. To locate mobile sessions, you search for an event that occurs in every session,
such as Hit Count, which is also associated with the Traffic Type dimension.
Whenever that event fires, the value of the Traffic Type dimension is also
recorded with the event data in the request.

4. The combination of event=Hit Count and dimension=Hit Count and
dimension_value=MOBILE is then used to locate sessions that Tealeaf identified
as being sourced from a mobile device.

v For more information about searching for mobile sessions, see “Search for
mobile visitors or sessions.”

Search for mobile visitors or sessions
The ability to search for mobile sessions requires that extended user agent parsing
is enabled in the Tealeaf Reference session agent that is deployed in your pipeline.
Some search capabilities rely on other Tealeaf CX platform components.
v See "Tealeaf Reference Session Agent" in the IBM Tealeaf CX Configuration Manual.
v See Chapter 3, “Search and Replay for Mobile Apps,” on page 21 to search for

mobile sessions from native applications.
v See "Searching for Visitors" in the IBM Tealeaf cxResults User Manual to search for

mobile visitors. cxResults is a separately licensable component of the Tealeaf CX
platform. For more information, please contact your IBM Tealeaf representative.

Searching for mobile sessions by Traffic Type
Use traffic type to search for mobile sessions.
1. From the Portal menu, select Search > Completed Sessions.

v You can select Active Sessions or All Sessions. These search options are
available for those types of searches, as well.

v See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.
2. Select the Completed search template, if it is not selected already.
3. From the Search Scope, select AND - Same Session.
4. In the search pane, click Event Values.
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5. Click <Select an event. In the Event Selector, select Hit Count.
6. Next, select the >= value from the drop-down. Enter the value 2.
7. In the Search pane, click Events. A second search term is added.
8. In the Events pane, Click <Select an event. In the Event Selector, select Hit

Count.
9. Click Any Dimension.

10. In the Dimension Selector, select Traffic Type and click Select.
11. The Dimension Value Selector is displayed. Select Mobile.

Note: If you have Tealeaf license and deployed a Tealeaf client framework to
capture session data from mobile native applications, you can search for
sessions of those types by selecting the value Mobile_App from the Dimension
Value Selector. See "Integrating Client Framework Data into Tealeaf" in the
IBM Tealeaf Client Framework Data Integration Guide.
v Click Select.

12. The search screen look like:

Portal Search Configured to Find Mobile Sessions
13. Click Search.
14. Results are displayed in a session list.

v See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Replay

Mobile Replay overview
You can replay visitor sessions that were experienced through mobile devices
through Browser-Based Replay through the Tealeaf Portal.

IBM Tealeaf UI Capture can provide better dimensions. Therefore, it is
recommended to have UI Capture installed for better replay of mobile sessions.
v The Chrome renderer must be enabled. See "Configuring the Replay Server" in

the IBM Tealeaf CX Configuration Manual.

Browser-based replay

Sessions that are requested by a BBR user are passed by the Replay Server to a
renderer that is appropriate for the source of the session. For example, Firefox
sessions are passed to the Gecko renderer, while Chrome/WebKit sessions are
passed to the Chrome renderer.
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For BBR, sessions that are delivered for replay are rendered on the Replay Server.
This content is delivered to Tealeaf user's browser and rendered in an iframe inside
of that browser.

Browser-specific styling cannot be appropriately applied to sessions that are
delivered to a different type of browser. For example, WebKit-specific styles cannot
be applied to a session that is rendered for and delivered to a Firefox browser.

For more information about BBR, see "CX Browser Based Replay" in the IBM
Tealeaf cxImpact User Manual.

Mobile skin

A mobile license is required for the mobile skin to show in the Mobile Replay.

IBM® Tealeaf receives mobile dimensions from two sources, IBM Tealeaf UI
Capture and WURFL. WURFL is used as a fallback if UI Capture is not installed. If
both sources are missing, there is no data to render the mobile skin. A default
dimension is applied and you see the skin with no page inside.

Limitations in Replay of mobile visitors
Replay of mobile visitor sessions works best for web pages that are designed for a
mobile platform. These web pages are designed to fit the smaller screens of mobile
devices and work well within the limitations of the device.

For more information about replay for mobile native applications, see Chapter 3,
“Search and Replay for Mobile Apps,” on page 21.

Personal computer designed web pages

Replay of web pages that are targeted for personal computers can vary widely
from the actual experience. Many cell phones and cell phone networks modify the
web page to best fit the display. Typical modifications include collapsing of frames,
restructuring of tables, and resizing of images.

Because these modifications are specific to the device or network, Tealeaf does not
attempt to emulate these behaviors. As standards improve for presentation of
content that is targeted for personal computer screens delivered to small mobile
screens, Tealeaf improves this emulation.

Mobile browser designed web pages

Replay of sessions for mobile devices that are captured from web applications that
are designed for mobile browsers is likely to feature improved performance and
visual display. However, if the content is delivered for a mobile-only device, there
can be visual discrepancies in the replay, due to differences in the rendering and
display issues of the browser controllers that are used in BBR.

Depending on the pixel density of the device and the pixel density of the monitor
on which you are viewing the replay, the physical size of the displayed image
cannot match the original image.

For Android devices, if the width or height is fewer than 320 pixels, the image is
not scaled.
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Limitations for unlicensed components

When IBM Tealeaf CX Mobile module is not licensed, the following limitations are
applied to replay of mobile-based sessions:
v No display of mobile-specific events, such as scroll and touch
v No display of mobile device data during replay
v No use of a mobile skin (Extended user agent parsing is also required.)
v No display of device orientation changes
v No resizing of the screen to the mobile browser dimensions

The underlying data is captured independent of the license; enabling the license
allows mobile-based replay of already captured sessions. See Chapter 1, “IBM
Tealeaf CX Mobile,” on page 1.

Android-based device Replay limitations
Some mobile replay limitations are because of the basic differences between mobile
web design and desktop web design. Some mobile replay limitations are
device-based.

Android-based device Replay limitations include:
v Android-based devices can screen capture the main window but cannot capture

pop-up windows.
v For hybrid applications, screen capture can be captured in a random order, and

some screen capture can be missing due to timing issues.
v Clicks of the device buttons are not captured by the Android logging

framework.
v When an Android-based web browser is minimized, the application is slept,

instead of killed. As a result, session identifiers are not renewed when the
application is reawakened, and the same session identifier can be used for what
are two separate visitor sessions. When hits from this visitor's sessions are
gathered into Tealeaf, the session data is mixed under a single session identifier.
For more information about debugging this issue, see "Tealeaf Android Logging
Framework Installation and Implementation" in the IBM Tealeaf Android Logging
Framework Guide.

BBR configuration
You can configure the BBR by using following steps:

Configuring BBR to auto-resize the screen for user groups
Through the Portal Management page, Tealeaf administrators can configure BBR
replay to auto-resize according to the screen of the visitor's device for Tealeaf user
groups.
1. Log in to the Tealeaf Portal as an administrator.
2. In the Portal menu, select Tealeaf > Portal Management.
3. In the left pane, click CX User Administration.
4. Click Groups.
5. Select the group.
6. Click Browser Replay Profile.
7. Select the Resize Replay pane to Match Session check box.
8. Click Save.
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Resizing the BBR replay screen for a session
When a session is selected for replay in BBR, you can resize the display window
that is based on the information that is provided by the visitor's browser.

In BBR, select Options > Options > Resize Replay Pane to Match Session.
If device window size information is available in the user agent data for the

visitor's browser, then that window size is applied to BBR.

Replaying mobile sessions
You can replay mobile sessions by using the same controls to replay desktop
sessions.

During the replay, you can resize the window based on the visitor's browser. For
more information about resizing the window that is based on the visitor's browser,
see “Resizing the BBR replay screen for a session.”
1. In the Sessions List, select the session to replay.

v If you searched by visitor, click the Sessions link next to the appropriate
results in the Visitors List.

Figure 1. BBR options for mobile devices
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2. To replay, click the Camera icon ( ).
3. In the Replay Session dialog, click Browser.
4. BBR is opened to replay the session.
5. For more information about resizing the window that is based on the visitor's

browser, see “BBR configuration” on page 15.

For more information about Browser-Based Replay, see "CX Browser Based Replay"
in the IBM Tealeaf cxImpact User Manual.

Figure 2. Searching for Mobile Sessions in BBR

Figure 3. BBR replay of a mobile device
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v If UI Capture is licensed and deployed, more UI events are displayed during
replay. See “User interface events captured from mobile browsers in BBR” on
page 19.

User agent information shown above title bar in the BBR pane
User agent information is inserted in a title bar above the replay pane.

This information is available only if the IBM Tealeaf CX Mobile module is licensed
and properly configured. See "Configuring Tealeaf for Mobile Visitors" in the IBM
Tealeaf CX Mobile Administration Manual.

This table lists and describes the item and the source Request field:

Table 2.

Item Source Request field Description

Browser TLT_BROWSER Visitor browser type

v This value is also available
in the Tealeaf System Hit
Attribute Browser. See
"TEM Hit Attributes Tab"
in the IBM Tealeaf Event
Manager Manual.

Browser Platform TLT_BROWSER_PLATFORM The mobile device platform

Browser Major Version TLT_BROWSER_VERSION The version X.0 of the
browser

Traffic Type TLT_TRAFFIC_TYPE The type of traffic, as
identified by extended user
agent parsing

v This data is also captured
in the Traffic Type
dimension. See "TEM
Dimensions Tab" in the
IBM Tealeaf Event Manager
Manual.

Replay Renderer The type of renderer that is
used by Replay Server to
render the session

v The type of renderer is
determined by the
configured renderer types
and the browser from
which the session was
originally experienced. See
"Configuring the Replay
Server" in the IBM Tealeaf
CX Configuration Manual.

Information shown in replay pane for mobile session
The BBR replay pane is rendered at the screen dimensions reported by the mobile
browser.

If no screen information is shown in the title bar for a mobile session, the screen
dimension data was not inserted into the request by the Windows pipeline session
agent. This omission typically occurs when the mobile browser cannot display
JavaScript or that feature is disabled.
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More configuration is required. See “BBR configuration” on page 15.

Screen Dimensions for Mobile Devices
BBR and RTV have multiple mechanisms for evaluating the screen dimensions as
reported from the mobile device.
1. If UI Capture is deployed and is submitted UI events to Tealeaf for capture,

then the screen dimensions that are used in replay are taken UI events that are
captured in first hit of the session in replay from the browser of the mobile
device.

2. If UI Capture is not deployed or if UI events are not reported and captured in
the first hit, then screen dimensions are taken from the WURFL standard for
the device that is used by the visitor.

Note: Since the device and the browser for the device can not report the same
values, it is possible that replay of a session by using the screen dimensions
reported by WURFL can not exactly match the dimensions of the captured
session.

3. If neither of the methods yields values for the screen dimensions, BBR and RTV
set the screen dimensions during replay to the full, normal replay size.

User interface events captured from mobile browsers in BBR
If UI Capture is deployed, user interface events that are captured from mobile
browsers are displayed in the Viewable Pages List in BBR.
v See the IBM Tealeaf UI Capture for j2 Guide.

Replay of scroll events that are captured by UI Capture is supported for mobile
sessions only in BBR.

In addition to actions such as clicks, gestures such as pinching and zoom in and
zoom out are displayed in BBR.

When the orientation changes in the session, the mobile skin is displayed along the
new axis in BBR.

Troubleshooting
This section contains some basic troubleshooting information for replay of mobile
visitor sessions.

Traffic Type is not populated
You are trying to replay a mobile session in BBR and the Traffic Type values is set
to ????

In this case, mobile replay cannot be properly configured. Support for mobile
replay requires a separate installation and configuration and is not enabled by
default. You cannot download, install, and convert the public standard WURFL.csv
for use in Tealeaf.

Use of WURFL conversion tools is a component of CX Mobile, a separately
licensable component of the Tealeaf CX platform. For more information, please
contact your IBM Tealeaf representative.
v See "Configuring Tealeaf for Mobile Visitors" in the IBM Tealeaf CX Mobile

Administration Manual.
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UI Events are not displayed in mobile session replay
You do not see UI events in a mobile session replay.

If you do not see UI events in a mobile session replay, check the request of any hit
in the session to see whether TLT_BROWSER_JAVASCRIPT=false is in the
[ExtendedUserAgent].

The UI Capture JavaScripts required to capture and submit UI events cannot run
for a session if a visitor's browser:
v does not support JavaScript
v is not configured to enable JavaScript to run
v See "Browser Based Replay Interface" in the IBM Tealeaf cxImpact User Manual.
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Chapter 3. Search and Replay for Mobile Apps

Mobile app sessions can be captured and replayed as screen captures for visual
review and data analysis.

IBM Tealeaf CX Mobile Android Logging Framework and IBM Tealeaf CX Mobile
iOS Logging Framework can be enabled to capture native mobile app data.

Sessions can be captured as HTML representations with information related to
multiple screens. Sessions that are rendered through HTML representation of the
native mobile session can be replayed only in Browser Based Replay.

For all sessions sourced from mobile native applications, you can search through
the Portal to locate them.

Define the attributes and event objects to capture
Before you can search for attributes and event objects, you must configure the
attributes and event objects you want to capture. You can capture important data
from your mobile native applications.
v See "Integrating Client Framework Data into Tealeaf" in the IBM Tealeaf Client

Framework Data Integration Guide.

Replaying mobile app sessions through JSON requires configuration of the IBM
Tealeaf Logging Framework.
v CX Mobile Android Logging Framework: See "UPDATE TITLE HERE" in the

IBM Tealeaf CX Mobile Android Logging Framework Guide.
v CX Mobile iOS Logging Framework: See "UPDATE TITLE HERE" in the IBM

Tealeaf CX Mobile iOS Logging Framework Guide.

Identify mobile app sessions with Mobile Device
Mobile app session data from mobile native applications has specific information
in the HTTP header. The header information identifies the device, framework, and
version of the capturing framework.

Haader information

In session data, sessions that are generated from mobile native applications are
identified by the following request variable, which is inserted into the HTTP
header:
HTTP_X_TEALEAF=device (<framework>) Lib/<version>

Where
v device = a hardcoded string
v <framework> = iOS or Android

v Lib/ = a hardcoded string
v <version> = the version number of the capturing framework

For JSON-based versions of UI Capture, the header value is UIC in the format:
HTTP_X_TEALEAF=device (<framework>) Lib/<version>
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Where
v device = a hardcoded string
v <framework> = iOS or Android

v Lib/ = a hardcoded string
v <version> = the version number of the capturing framework
v For XML-based versions of UI Capture, the header is the following exactly:

HTTP_X_TEALEAF=ClientEvent

Mobile Device Type hit attribute

For all client framework sessions, the header information is detected by the Mobile
Device hit attribute. This hit attribute detects the values for the <framework> value.

Mobile Device dimension

The values that detected by using the Mobile Device hit attribute are recorded to
the Mobile Device dimension.
v If the Mobile Device Type hit attribute is found, the Mobile Device building

block event is triggered. This event is used only to record the values into this
dimension.

These values can be recorded:

Dimension Value
Description

iOS Indicates a session that is captured from an iOS device by the IBM Tealeaf
CX Mobile iOS Logging Framework

Android
Indicates a session that is captured from an Android device by the IBM
Tealeaf CX Mobile Android Logging Framework

null value

Note: For any other session, including sessions that are captured from IBM
Tealeaf CX UI Capture j2, a null value is recorded.

Associated events

The Mobile Device dimension is pre-configured to be included in the Traffic Type
report group. This report group is associated with a number of events that are
provided by Tealeaf. When those events are triggered, values for the Mobile Device
dimension are recorded as soon as the installation or upgrade is completed.
v The Page Count event is used as an example event for locating sessions by using

this dimension. This event occurs once per session at the end of the session,
which provides the means of scanning all sessions for this dimension value.
The Page Count event is evaluated at the end of the session. It cannot be used as
a means of locating mobile native application sessions among your active
sessions because the event not yet fired in active sessions.
– You can use the Mobile Device dimension to locate active sessions. To locate

active sessions, associate the dimension or one of its report groups with an
event that occurs on the first hit of the session, every hit, after every hit, or
any step-based trigger.
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You can use the Report Builder to identify the events with which a dimension is
associated. See "Tealeaf Report Builder" in the IBM Tealeaf Reporting Guide.

v You can associate the Traffic Type report group with other dimensions or the
Mobile Device dimension with other report groups to expand access to this
segmenting information.

v For more information about associating dimensions and report groups with
events, see "TEM Events Tab" in the IBM Tealeaf Event Manager Manual.

Search session data
You can use the Tealeaf Portal to search session data.
v For more information about portal search in general, see "Searching Session

Data" in the IBM Tealeaf cxImpact User Manual.

Searching sessions in the Portal by dimension value
Using the provided event objects, you can search for completed sessions from
mobile native applications through the Portal.

This example uses an event that is calculated on each session but not until the end
of the session. So, this example cannot be used to find all instances among active
sessions. To locate active sessions, you must select a different event, which occurs
on every hit.
1. Log in to the Portal.
2. From the Portal menu, select Search > Completed Sessions.
3. Specify the template and Search Range as needed.
4. To remove any fields in the search panel, click the X icon in the upper-right

corner.
5. In the left panel, click the Events category.
6. The Events search field is added to the search panel.

v If this field is not available, you must select a different search template. See
"Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

v If no search template contains this field, it must be added to at least one
search template. See "Configuring Search Templates" in the IBM Tealeaf
cxImpact Administration Manual.

7. Optional: Search for the occurrence of specific events and dimension values. In
this example, the provided Tealeaf event Page Count is used, and the Mobile
Device dimension is already associated with it.
v For more information about creating events to track mobile native

application data, see "Integrating Client Framework Data into Tealeaf" in the
IBM Tealeaf Client Framework Data Integration Guide.

a. Click <Select an event.
b. In the Event Selector, open the Tealeaf Standard Events label.
c. Select the Page Count event. Click Select.
d. The Page Count event is selected.
e. Click Any Dimension.
f. In the Dimension Selector, select the Mobile Device dimension.

If the Mobile Device dimension is not available, the report group that
contains it (Traffic Type report group) is not associated with the event that
you selected to use.
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g. In the Dimension Value Selector, select either Android or IOS depending on
the type of session for which you are searching.

h. Click Select. The dimension value is selected as part of the search term.
8. Optional: Search for sessions from one of multiple mobile native application

frameworks:
a. Change the Search Scope value to OR - Any Session.
b. Repeat the steps to add the Page Count event by using the Mobile Device

dimension.
c. For the dimension value, select a different mobile native application type.

9. Optional: Search for sessions that are initiated from either iOS or Android
devices. Set your search page to look like:

10. Optional: Modify your search as needed.
Set the Search Range to be as narrow as possible to locate the necessary
sessions.

11. When you are ready to search, click Search. Results are displayed in the
default session list. See “Search Results”

Search Results
After your search results are returned, they are displayed in the default session list
template that is associated with the search template that you used.

This diagram shows the Portal Search Results for a search for all mobile sessions.

Figure 4. Portal Search - Event + Dimension Value search terms
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The session list includes columns for the user identifier that is captured by each of
the deployed Logging Frameworks.
v For more information about configuring search templates, see "Configuring

Search Templates" in the IBM Tealeaf cxImpact Administration Manual.

This table lists and describes the available commands:

Table 3. Search Results.

Command Icon Description

Replay Displays the session in the browser.
See “Replay mobile app sessions as
screen captures” on page 28.

Figure 5. Portal Search - Search Results
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Table 3. Search Results (continued).

Command Icon Description

Page List View the page list for the session.
See "Searching Session Data" in the
IBM Tealeaf cxImpact User Manual.

QuickView Open session QuickView, where you
can review the event and
dimensional data for every event that
was triggered in the session.
See "Searching Session Data" in the
IBM Tealeaf cxImpact User Manual.

Session Info View session properties. See
"Searching Session Data" in the IBM
Tealeaf cxImpact User Manual.

Send to
Event Tester

Send the selected session to the Event
Tester as sample data. See "Event
Tester" in the IBM Tealeaf Event
Manager Manual.

See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Replay Mobile App Sessions as HTML web sessions
The HTML representation method replays a mobile app session in Browser Based
Replay as it would an HTML web session. Without the HTML representation
method, you would view the mobile app session as a series of screen captures.

Advantages

There are several advantages to using the HTML representation method to replay
mobile app session over screen captures.
v Ability to mask private information
v Ability to draw user interactions (UI events) onto the HTML pages that are

created from the JSON data
v Smaller data size

JSON data

The HTML Representation method uses JSON data that is captured by the CX
Mobile Logging Frameworks to create a collection of HTML pages. Each page is a
collection of UI events within a JSON string. When the Replay Server finds a hit
with a JSON string:
v Type 10 messages are converted into HTML through a template engine to render

the collection of HTML pages that represent the mobile app screens
v Type 4 messages that follow a Type 10 message are filtered to produce

associated UI Events that are visible in the Navigation List

The message breakdown provides you with a deeper insight into your mobile app
sessions.
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Templates

The templates that are used by the template engine can be customized to meet
your business needs. To configure your templates, contact IBM Tealeaf Professional
Services or see "Native app session replay customization in the IBM Tealeaf CX
Configuration Manual.

Naming conventions

When you replay a mobile app session and use a Tealeaf Target page that does not
match the naming convention of TealeafTarget.*, you might see native UI events
that are associated to your unconventional Tealeaf Target pages when they belong
to an earlier page. To avoid this association, create an Ignore URL replay rule to
filter your unconventional Tealeaf Target pages out of the Navigation List.

Configuration

Replaying mobile app sessions through HTML representation requires
configuration of the IBM Tealeaf Logging Framework.
v CX Mobile Android Logging Framework: See "Log Screen Layout for Android

Mobile App Replay" in the IBM Tealeaf CX Mobile Android Logging Framework
Guide.

v CX Mobile iOS Logging Framework: See "Log Screen Layout for iOS Mobile App
Replay" in the IBM Tealeaf CX Mobile iOS Logging Framework Guide.

Note: If you replay a mobile app session with no CX UI Capture j2 data, the
mobile skin might be large. The large mobile skin is because IBM Tealeaf did not
receive any data from CX UI Capture j2. When there is no CX UI Capture j2 data,
User Agent data is the fallback. The User Agent data might not be a correct or
normalized properly.
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HTML Representation limitations
When replaying HTML representations of sessions that are generated from
Android apps, there are often empty target pages in the Navigation List. During
rendering, the target pages are converted to ScreenViews and UI Events. However,
the original target pages remain in the Navigation List and appear as empty
pages.

You can use the Ignore URLs rule to remove any of these original pages from the
Navigation List that are not required.

To remove these original pages from the Navigation List, right-click the
target.php page in the Navigation list, and click Remove this page from Replay.

The Ignore URLs rule does not work on sessions that are generated from iOS apps.

Replay mobile app sessions as screen captures
You can replay sessions with mobile app screen captures in Browser Based Replay.

Screen capture requires configuration of the IBM Tealeaf Logging Framework.
v Android Logging Framework: See the IBM Tealeaf Android Logging Framework

Guide.
v iOS Logging Framework: See the IBM Tealeaf iOS Logging Framework Guide.
v “BBR session replay” on page 30

28 IBM Tealeaf CX Mobile: Tealeaf CX Mobile User Manual



Replay screen capture limitations
As the visitor steps through different views of the native application, a screen
capture can be captured and submitted to Tealeaf for display. During display of
mobile native apps, static screen captures of each view are displayed.

Screens are captured as soon as the view is initialized and before data is populated
in any fields. It limits the exposure of sensitive data to Tealeaf.

For Android-based sessions, images that are captured from the web server are
stored at the beginning of the session. Images that are captured from the local
instance of the native application are stored in the appropriate locations
throughout the session.

Mobile native application sessions are not replayed by using the mobile skin.

There is a known issue in which the PCA fails to properly recognize UTF-8
encoding in data that is submitted from client frameworks. The data can be
mangled in the stored session, causing issues in eventing and search.

Attention: The following information applies to IBM Tealeaf version 9.0A only.
9.0A can properly recognize UTF-8 encoding in data that is submitted from client
frameworks.

User agent requirement
The user agent string must match a user string in the public standards that was
deployed into your Tealeaf solution.

Your client framework must be configured to report a user agent string in the
HTTP_USER_AGENT request header. If the framework is configured differently, the
extended user agent parsing information that is displayed in BBR is reported as
unknown in the toolbar at the top of replay view.
v Capture of user agent information requires more configuration. For more

information about user agent detection, see "Managing User Agents" in the IBM
Tealeaf cxImpact Administration Manual.

How browser-specific features are rendered in BBR replay
Sessions that are requested by a BBR user are passed by the Replay Server to a
renderer that is appropriate for the source of the session. For example, Firefox
sessions are passed to the Gecko renderer, while Chrome/WebKit sessions are
passed to the Chrome renderer.

To render sessions that are captured from mobile devices for display in the web
browser, the Tealeaf Replay Server uses an embedded renderer that is based on the
Chromium engine. For best results in replay of mobile-based sessions, Tealeaf
recommends that you use the Chrome browser in Browser-Based Replay.

The Chrome renderer must be enabled. See "Configuring the Replay Server" in the
IBM Tealeaf CX Configuration Manual.

Browser-specific styling cannot be appropriately applied to sessions that are
delivered to a different type of browser. For example, WebKit-specific styles cannot
be applied to a session that is rendered for and delivered to a Firefox browser.
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Image capture screen dimensions for mobile devices
If the IBM Tealeaf CX Mobile license and extended user agent parsing is enabled,
captured images are displayed in the screen dimensions that are used on the
mobile device.

This device is the same device from which the native application session was
captured.

For mobile native application sessions, image display is determined by the Logging
Framework, which always screen captures the currently configured resolution for
the device. The dimensions cannot be configured in BBR for mobile native
application sessions.

For the Android logging framework, the screen capture's dimensions are
represented in the left navigation bar, and the image is resized in BBR. If the
Android device has a width or height fewer than 320 pixels, the image is not
scaled.
v For more information about extended user agent parsing, see "Managing User

Agents" in the IBM Tealeaf cxImpact Administration Manual.

BBR session replay
In BBR, you can review screen images by selecting the appropriate items in the
Navigation List. These entries signify that a new view is loaded but not populated
with data yet.

This diagram shows the Navigation List:
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In the Navigable Pages List, mobile native application views and user interface
changes are not numbered.

For more information on Browser Based Replay, see "CX Browser Based Replay" in
the IBM Tealeaf cxImpact User Manual.

Interaction timing

If your mobile native application enables web-based interactions with a web server
that is monitored by Tealeaf, these web interactions are transmitted as soon as they
occur.

Mobile native application interactions are batched and submitted periodically. They
are timestamped by the PCA after web interactions, which are submitted in real
time. During replay, the web interactions can be listed and displayed before the
mobile native application interactions that occurred beforehand. This issue is
addressed in a later build.

Depending on how data is captured by the Logging Framework and client
application, user data can be available in the Navigable List entries between the
screen capture entries.

Recommended Browser-Based Replay configuration
For best results in displaying sessions through BBR, IBM Tealeaf recommends
specific configuration settings in BBR.

Figure 6. Mobile Native Application - BBR Session Replay
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Options that are not referenced here can be specified based on your Tealeaf
environment.

Table 4. BBR configuration. This table lists and describes the recommended BBR
configuration settings.

Setting Value Notes

View > User Agent Info Do not select. By default, user agent information is not
populated for mobile native applications. See
"Tealeaf Reference Session Agent" in the IBM
Tealeaf CX Configuration Manual.

Options > Page
Numbering > Use Hit
Numbers

Select. When the list of pages is displayed by hit
number, then items are numbered in the
following format:

<Letter><Index>

where:

v <Letter> corresponds to an alphabetical
letter, each of which identifies a different
session fragment.

v <Index> corresponds to the index of views
within an ScreenView.

Options > Page Naming
> Use Page Title

Select. When selected, you can easily see which pages
are marked as Tealeaf Target. Some of the
Tealeaf Target pages identify the screen
captures to review.

v When deselected, pages are displayed by
URL, which may require you to widen or
scroll the Navigable Page List to review.

Options > Advanced >
Merge Session
Fragments

Do not select. Since mobile native applications are sessioned
in a different manner, this option does not
work for mobile native application display.

Options > Advanced >
Report Javascript Errors

Do not select. Does not apply.

Options > Resize View
to Match Session

Do not select. Replay pane is auto-resized to the size of the
screen capture that is provided by the Logging
Framework. This setting requires user agent
information to apply. See “User agent
requirement” on page 29.

See "CX Browser Based Replay" in the IBM Tealeaf cxImpact User Manual.

See "BBR Options" in the IBM Tealeaf cxImpact User Manual.
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Chapter 4. Events for mobile visitors

Through WURFL reference data, Tealeaf can be configured to identify mobile
visitors that are based on data that is stored in the request by Tealeaf. You can
configure Tealeaf to detect mobile visitors and to generate events to detect them.

Enable extended user agent detection

To identify mobile visitors through WURFL reference data, you must enable User
Agent Detection.
v See "Configuring User Agent Detection" in the IBM Tealeaf cxImpact

Administration Manual.

Import CX Mobile Dashboard

The IBM Tealeaf CX Mobile module includes a suite of events for mobile visitors.
These events can be imported with the Mobile Traffic Dashboard, which must be
imported into your Tealeaf solution.

How mobile visitors are detected

When extended user agent detection is enabled, the data relevant to mobile devices
is captured and inserted into the [ExtendedUserAgent] section of request by the
Tealeaf Reference session agent.

The Tealeaf Reference session agent must be enabled in your Tealeaf processing
pipeline.
v See "Tealeaf Reference Session Agent" in the IBM Tealeaf CX Configuration Manual.
v See "TMS Pipeline Editor" in the IBM Tealeaf cxImpact Administration Manual.

How Mobile Visitors Are Detected
When extended user agent detection is enabled, the data relevant to mobile devices
is captured and inserted into the [ExtendedUserAgent] section of request by the
Tealeaf Reference session agent.

The Tealeaf Reference session agent must be enabled in your Tealeaf processing
pipeline.
v See "Tealeaf Reference Session Agent" in the IBM Tealeaf CX Configuration Manual.
v See "TMS Pipeline Editor" in the IBM Tealeaf cxImpact Administration Manual.

Information inserted into the request
When the Tealeaf Reference session agent detects a mobile session, the WURFL
standard is checked and any available information is inserted into the request.

This code is an example of the [ExtendedUserAgent] section of request:
[ExtendedUserAgent]
TLT_BROWSER=Openwave Mobile Browser
TLT_BROWSER_VERSION=Openwave Mobile Browser6.2
TLT_BROWSER_PLATFORM=
TLT_TRAFFIC_TYPE=MOBILE
TLT_BROWSER_JAVASCRIPT=false
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TLT_BROWSER_COOKIES=true
TLT_BRAND=LG
TLT_MODEL=LG MX510
TLT_SCREEN_HEIGHT=220
TLT_SCREEN_WIDTH=176
TLT_COLOR_DEPTH=65536
TLT_PICTURE_SUPPORT=true
TLT_VIDEO_SUPPORT=false
TLT_STREAMING_SUPPORT=false

How self-reporting mobile web browsers are identified
Self-reporting mobile browsers are identified in the Tealeaf Canister based on the
value of the extended user agent variable.

When the [ExtendedUserAgent] variable TLT_TRAFFIC_TYPE=MOBILE value is set to
MOBILE, the user agent is a mobile device. This value is used to populate the
provided session attribute Browser Traffic Type, which contains the value MOBILE
for these self-reporting mobile browsers.

This session attribute can then be referenced in your event definitions.

Identify mobile web applications by Traffic Type dimension
With the Android and iOS logging frameworks, you can use the Traffic Type
dimension to identify sessions that were captured.

You must have licenses for these products to use the Traffic Type dimension to
identify sessions:
v IBM Tealeaf Android Logging Framework Guide

v IBM Tealeaf iOS Logging Framework Guide

These client frameworks submit user agent information for capture by Tealeaf. The
Tealeaf Reference session agent interprets the user agent information and populates
the [ExtendedUserAgent] section, including the TLT_TRAFFIC_TYPE variable:
TLT_TRAFFIC_TYPE=MOBILE_APP

When this value is set to MOBILE_APP, the user agent is a mobile native application.

This value is displayed in the Traffic Type dimension. See “Use the Traffic Type
dimension to identify sessions from self-reporting browsers” on page 50.

Request variable reference
Request variables are used in events.

This table lists and describes the request variables:

Header Header

TLT_BROWSER Browser type for the mobile device.

TLT_BROWSER_VERSION The version of browsers for the mobile
device.

TLT_BROWSER_PLATFORM The operating system in use, if the device is
a mobile one.

TLT_TRAFFIC_TYPE The type of traffic for the device.
Self-reporting mobile devices have this value
that is set to MOBILE.
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Header Header

TLT_BROWSER_JAVASCRIPT Does the device accept and run JavaScript?
Possible values: True, False, or Unknown,
which means that the data is not present.

TLT_BROWSER_COOKIES Does the device accept cookies? Possible
values: True, False, or Unknown, which
means that the data is not present.

TLT_BRAND The brand of the mobile device.

TLT_MODEL The model name for the mobile device.

TLT_SCREEN_HEIGHT Height of the screen in the mobile device.

TLT_SCREEN_WIDTH Width of the screen in the mobile device.

TLT_COLOR_DEPTH Number of colors that the device can
display.

TLT_PICTURE_SUPPORT Does the device support display of picture
formats? Possible values: True, False, or
Unknown, which means that the data is not
present.

TLT_VIDEO_SUPPORT Does the device support download of video?
Possible values: True, False, or Unknown,
which means that the data is not present.

TLT_STREAMING_SUPPORT Does the device support video streaming?
Possible values: True, False, or Unknown,
which means that the data is not present.

Mobile Events
Tealeaf provides a set of Mobile events to support the tracking of user interface
events that are captured through a Tealeaf client framework. These objects can be
used as the basis for building other event objects for tracking the specifics of your
client application.

Information about Mobile

The IBM Tealeaf CX Mobile module is a separately licensed module of the IBM
Tealeaf CX platform. please contact your IBM Tealeaf representative.

Double Tap Gesture
.session(0) message Event

Display Name
Double Tap Gesture

Internal Name
CUST.E_DOUBLE_TAP_GESTURE

Advanced Mode
true

Description
.session(0) message Event

ImageSrc
default.gif
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DisplayInPortal
true

DisplayInSessionList
true

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_DOUBLE_TAP_GESTURE()
{

if ($F.factCount("TL.F_E_MOBILE_SESSION_START_BB") > 0 && $P["TL.P_
SESSIONS_0_MESSAGE_STEP_ENTRY_IN_REQUEST"].firstValue().
toUpperCase() == "DOUBLETAP")

{
// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_DOUBLE_TAP_GESTURE", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group
$F.setFact("CUST.F_E_DOUBLE_TAP_GESTURE_FACT2", "TLT$NULL");

}
}

Exception
General exception

Display Name
Exception

Internal Name
CUST.E_EXCEPTION

Advanced Mode
true

Description
General exception

ImageSrc
default.gif

DisplayInPortal
true

DisplayInSessionList
true

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_EXCEPTION()
{

if ($F.factCount("TL.F_E_MOBILE_SESSION_START_BB") > 0 && $P["TL.STEP_
MESSAGE_TYPE"].firstValue().toUpperCase() == "6")

{
// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_EXCEPTION", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group
$F.setFact("CUST.F_E_EXCEPTION_FACT2", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group 3
$F.setFact("CUST.F_E_EXCEPTION_FACT3", "TLT$NULL");

}
}
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Gesture
Any recorded gesture qualifies.

Display Name
Gesture

Internal Name
CUST.E_GESTURE

Advanced Mode
true

Description
Any recorded gesture qualifies.

ImageSrc
default.gif

DisplayInPortal
true

DisplayInSessionList
true

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_GESTURE()
{

if ($F.factCount("TL.F_E_MOBILE_SESSION_START_BB") > 0 && $P["TL.STEP_
MESSAGE_TYPE"].firstValue().toUpperCase() == "11")

{
// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_GESTURE", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group
$F.setFact("CUST.F_E_GESTURE_FACT2", "TLT$NULL");

}
}

Mobile Model
Mobile model name

Display Name
Mobile Model Name

Internal Name
CUST.E_MOBILE_MODEL

Advanced Mode
true

Description
Mobile model name

ImageSrc
default.gif

DisplayInPortal
true

DisplayInSessionList
true
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JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_MOBILE_MODEL()
{

if ($F.factCount("TL.F_E_MOBILE_SESSION_START_BB") > 0 && $P["TLT.P__MODEL"].
patternFound())

{
// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_MOBILE_MODEL", $P["TLT.P__MODEL"].firstValue());

}
}

Mobile Session Count
Count of mobile sessions.

Display Name
Mobile Session Count

Internal Name
CUST.E_MOBILE_SESSION_COUNT

Advanced Mode
true

Description
Count of mobile sessions

ImageSrc
default.gif

DisplayInPortal
true

DisplayInSessionList
true

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_MOBILE_SESSION_COUNT()
{

if ($F.factCount("TL.F_E_MOBILE_SESSION_START_BB") > 0)
{

// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_MOBILE_SESSION_COUNT_DG_NONE", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group
$F.setFact("CUST.F_E_MOBILE_SESSION_COUNT_FACT1", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group 2
$F.setFact("CUST.F_E_MOBILE_SESSION_COUNT_FACT2", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group 3
$F.setFact("CUST.F_E_MOBILE_SESSION_COUNT_FACT3", "TLT$NULL");
// Set fact for Report Group: Device Model / OS Version
$F.setFact("CUST.F_E_MOBILE_SESSION_COUNT_FACT4", "TLT$NULL");

}
}

Mobile Session Length (sec)
Total length of the session in seconds (end of session).
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Display Name
Mobile Session Length (sec)

Internal Name
CUST.E_MOBILE_SESSION_SECS

Advanced Mode
true

Description
Total length of the session in seconds (end of session).

ImageSrc
default.gif

DisplayInPortal
true

DisplayInSessionList
false

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_MOBILE_SESSION_SECS()
{

if ($F.factCount("TL.F_E_MOBILE_SESSION_START_BB") > 0)
{

// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_MOBILE_SESSION_SECS_DG_NONE", $S.TotalTime);
// Set fact for Report Group: Traffic Type
$F.setFact("CUST.F_E_MOBILE_SESSION_SECS_DG_TLT_TRAFFIC_TYPE",

$S.TotalTime);
// Set fact for Report Group: Gesure Report Group 3
$F.setFact("CUST.F_E_MOBILE_SESSION_SECS_FACT1", $S.TotalTime);
// Set fact for Report Group: Gesure Report Group
$F.setFact("CUST.F_E_MOBILE_SESSION_SECS_FACT2", $S.TotalTime);

}
}

Mobile Session Size (MB)
Total of all Rep and Req sizes (end of session)

Display Name
Mobile Session Size (MB)

Internal Name
CUST.E_MOBILE_SESSION_MB

Advanced Mode
true

Description
Total of all Rep and Req sizes (end of session)

ImageSrc
default.gif

DisplayInPortal
true

DisplayInSessionList
false
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JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_MOBILE_SESSION_MB()
{

if ($F.factCount("TL.F_E_MOBILE_SESSION_START_BB") > 0)
{

// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_MOBILE_SESSION_MB_DG_NONE", $F.getLastFact

("TL.F_E_REPORT_WS_SESSION_MB_DG_NONE").NumericValue);
// Set fact for Report Group: Traffic Type
$F.setFact("CUST.F_E_MOBILE_SESSION_MB_DG_TLT_TRAFFIC_TYPE", $F.getLastFact

("TL.F_E_REPORT_WS_SESSION_MB_DG_NONE").NumericValue);
// Set fact for Report Group: Gesure Report Group 3
$F.setFact("CUST.F_E_MOBILE_SESSION_MB_FACT1", $F.getLastFact

("TL.F_E_REPORT_WS_SESSION_MB_DG_NONE").NumericValue);
// Set fact for Report Group: Gesure Report Group
$F.setFact("CUST.F_E_MOBILE_SESSION_MB_FACT2", $F.getLastFact

("TL.F_E_REPORT_WS_SESSION_MB_DG_NONE").NumericValue);
}

}

Mobile Session Start [BB]
Start of a mobile session.

Display Name
Mobile Session Start [MB]

Internal Name
CUST.E_MOBILE_SESSION_START_BB

Advanced Mode
true

Description
Start of a mobile session

ImageSrc
default.gif

DisplayInPortal
false

DisplayInSessionList
false

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function TL$E_MOBILE_SESSION_START_BB()
{

if ($P["TL.TLT_TRAFFIC_TYPE"].firstValue() == "MOBILE" ||
$P["TL.TLT_TRAFFIC_TYPE"].firstValue() == "MOBILE_APP")

{
// Set fact for Report Group: No Dimension Report Group
$F.setFact("TL.F_E_MOBILE_SESSION_START_BB", "TLT$NULL");

}
}

Pinch Gesture
.sessions(0) message Event
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Display Name
Pinch Gesture

Internal Name
CUST.E_PINCH_GESTURE

Advanced Mode
true

Description
.sessions(0) message Event

ImageSrc
default.gif

DisplayInPortal
true

DisplayInSessionList
true

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_PINCH_GESTURE()
{

if ($F.factCount("TL.F_E_MOBILE_SESSION_START_BB") > 0 && $P["TL.P_
SESSIONS_0_MESSAGE_STEP_ENTRY_IN_REQUEST"]
.firstValue().toUpperCase() == "PINCH")

{
// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_PINCH_GESTURE", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group
$F.setFact("CUST.F_E_PINCH_GESTURE_FACT2", "TLT$NULL");

}
}

Resize Gesture
Any pinch or double tap gesture

Display Name
Resize Gesture

Internal Name
CUST.E_RESIZE_GESTURE

Advanced Mode
true

Description
Any pinch or double tap

ImageSrc
default.gif

DisplayInPortal
true

DisplayInSessionList
true
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JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_RESIZE_GESTURE()
{

if ($F.factCount("TL.F_E_MOBILE_SESSION_START_BB") > 0 || $F.getLastFact("CUST.
F_E_DOUBLE_TAP_GESTURE").HitNumber == $H.HitNumber && $F.getLastFact
("CUST.F_E_DOUBLE_TAP_GESTURE").StepNumber ==
$H.StepNumber || $F.getLastFact("CUST.F_E_PINCH_GESTURE")
.HitNumber == $H.HitNumber && $F.getLastFact("CUST.F_E_PINCH_GESTURE").
StepNumber == $H.StepNumber)

{
// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_RESIZE_GESTURE", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group
$F.setFact("CUST.F_E_RESIZE_GESTURE_FACT2", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group 3
$F.setFact("CUST.F_E_RESIZE_GESTURE_FACT3", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group 2
$F.setFact("CUST.F_E_RESIZE_GESTURE_FACT4", "TLT$NULL");

}
}

Session with at least one exception
Any session that has at least one exception

Display Name
Session with at least one exception

Internal Name
CUST.E_SESSION_WITH_AT_LEAST_ONE_EXCEPTION

Advanced Mode
true

Description
Any session that has at least one exception

ImageSrc
default.gif

DisplayInPortal
true

DisplayInSessionList
true

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_SESSION_WITH_AT_LEAST_ONE_EXCEPTION()
{

if ($F.factCount("TL.F_E_MOBILE_SESSION_START_BB") > 0 && $F.
factCount("CUST.F_E_EXCEPTION") > 0)

{
// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_SESSION_WITH_AT_LEAST_ONE_EXCEPTION",

"TLT$NULL");
// Set fact for Report Group: Gesure Report Group
$F.setFact("CUST.F_E_SESSION_WITH_AT_LEAST_ONE_EXCEPTION_FACT2",

"TLT$NULL");
// Set fact for Report Group: Gesure Report Group 2
$F.setFact("CUST.F_E_SESSION_WITH_AT_LEAST_ONE_EXCEPTION_FACT3",
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"TLT$NULL");
// Set fact for Report Group: Gesure Report Group 3
$F.setFact("CUST.F_E_SESSION_WITH_AT_LEAST_ONE_EXCEPTION_FACT4",

"TLT$NULL");
}

}

Step - Device Carrier [BB]
Mobile Device Carrier BB Event for Dimensions

Display Name
Step - Device Carrier [BB]

Internal Name
CUST$E_STEP_CARRIER_BB

Advanced Mode
true

Description
Mobile Device Carrier BB Event for Dimensions

ImageSrc
default.gif

DisplayInPortal
false

DisplayInSessionList
false

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_STEP_CARRIER_BB()
{

if ($P["CUST.P_CARRIER"].patternFound())
{

// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_STEP_CARRIER_BB_DG_NONE", $P

["CUST.P_CARRIER"].firstValue());
}

}

Step - Last Gesture [BB]
Last Gesture BB for Unresponsive Gestures

Display Name
Step - Last Gesture [BB]

Internal Name
TL$E_LAST_GESTURE_BB

Advanced Mode
true

Description
Last Gesture BB for Unresponsive Gestures

ImageSrc
default.gif
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DisplayInPortal
false

DisplayInSessionList
false

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function TL$E_LAST_GESTURE_BB()
{

// Set fact for Report Group: No Dimension Report Group
$F.setFact("TL.F_E_LAST_GESTURE_BB", 1);

}

Step - Last Gesture Offset [BB]
Last Gesture Offset BB for Unresponsive Gestures

Display Name
Step - Last Gesture Offset [BB]

Internal Name
TL$E_LAST_GESTURE_OFFSET_BB

Advanced Mode
true

Description
Last Gesture Offset BB for Unresponsive Gestures

ImageSrc
default.gif

DisplayInPortal
false

DisplayInSessionList
false

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function TL$E_LAST_GESTURE_OFFSET_BB()
{

// Set fact for Report Group: No Dimension Report Group
$F.setFact("TL.F_E_LAST_GESTURE_OFFSET_BB", 1);

}

Step - Device Model [BB]
Mobile Device Model BB Event for Dimensions

Display Name
Step - Device Model [BB]

Internal Name
CUST$E_STEP_DEVICE_MODEL_BB

Advanced Mode
true
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Description
Mobile Device Model BB Event for Dimensions

ImageSrc
default.gif

DisplayInPortal
false

DisplayInSessionList
false

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_STEP_DEVICE_MODEL_BB()
{

if ($P["CUST.P_STEP_DEVICE_MODEL_STEP_ENTRY_IN_REQUEST"].patternFound())
{

// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_STEP_DEVICE_MODEL_BB_DG_NONE", $P["CUST.P_STEP_

DEVICE_MODEL_STEP_ENTRY_IN_REQUEST"].firstValue());
}

}

Step - OS Version [BB]
Mobile OS Version BB Event for Dimensions

Display Name
Step - OS Version [BB]

Internal Name
CUST$E_STEP_OS_VERSION_BB

Advanced Mode
true

Description
Mobile OS Version BB Event for Dimensions

ImageSrc
default.gif

DisplayInPortal
false

DisplayInSessionList
false

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_STEP_OS_VERSION_BB()
{

if ($P["CUST.P_STEP_OS_VERSION_ENTRY_IN_REQUEST"].patternFound())
{

// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_STEP_OS_VERSION_BB_DG_NONE", $P["CUST.P_

STEP_OS_VERSION_ENTRY_IN_REQUEST"].firstValue());
}

}
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Swipe Gesture
.sessions(0) message Event

Display Name
Swipe Gesture

Internal Name
CUST.E_SWIPE_GESTURE

Advanced Mode
true

Description
.sessions(0) message Event

ImageSrc
default.gif

DisplayInPortal
true

DisplayInSessionList
true

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_SWIPE_GESTURE()
{

if ($P["CUST.P_SESSIONS_0_MESSAGE_STEP_ENTRY_IN_REQUEST"]
.firstValue().toUpperCase() == "SWIPE")

{
// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_SWIPE_GESTURE", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group
$F.setFact("CUST.F_E_SWIPE_GESTURE_FACT2", "TLT$NULL");

}
}

Tap and Hold Gesture
.sessions(0) message Event

Display Name
Tap and Hold Gesture

Internal Name
CUST.E_TAP_AND_HOLD_GESTURE

Advanced Mode
true

Description
.sessions(0) message Event

ImageSrc
default.gif

DisplayInPortal
true

DisplayInSessionList
true

46 IBM Tealeaf CX Mobile: Tealeaf CX Mobile User Manual



JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_TAP_AND_HOLD_GESTURE()
{

if ($F.factCount("TL.F_E_MOBILE_SESSION_START_BB") > 0 && $P["TL.P_
SESSIONS_0_MESSAGE_STEP_ENTRY_IN_REQUEST"].firstValue().
toUpperCase() == "TAPHOLD")

{
// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_TAP_AND_HOLD_GESTURE", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group
$F.setFact("CUST.F_E_TAP_AND_HOLD_GESTURE_FACT2", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group 2
$F.setFact("CUST.F_E_TAP_AND_HOLD_GESTURE_FACT3", "TLT$NULL");

}
}

Unresponsive Gestures
Any unresponsive gestur.

Display Name
Unresponsive Gestures

Internal Name
CUST.E_UNRESPONSIVE_GESTURES

Advanced Mode
true

Description
Any unresponsive gesture

ImageSrc
default.gif

DisplayInPortal
true

DisplayInSessionList
true

JavaScript: (Advanced Mode only)
// Generated by Tealeaf Event Manager

// NOTE: Do not change event name
function CUST$E_UNRESPONSIVE_GESTURES()
{

if ($F.factCount("TL.F_E_MOBILE_SESSION_START_BB") > 0 && $F.getLastFact
("CUST.F_E_UNRESPONSIVE_GESTURES_BB").HitNumber ==
$H.HitNumber && $F.getLastFact("CUST.F_E_
UNRESPONSIVE_GESTURES_BB").StepNumber == $H.StepNumber)

{
// Set fact for Report Group: No Dimension Report Group
$F.setFact("CUST.F_E_UNRESPONSIVE_GESTURES", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group
$F.setFact("CUST.F_E_UNRESPONSIVE_GESTURES_FACT2", "TLT$NULL");
// Set fact for Report Group: Gesture Mobile Device
$F.setFact("CUST.F_E_UNRESPONSIVE_GESTURES_FACT3", "TLT$NULL");
// Set fact for Report Group: Gesure Report Group 3
$F.setFact("CUST.F_E_UNRESPONSIVE_GESTURES_FACT4", "TLT$NULL");

}
}
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Unresponsive Gestures [BB]
Detect root ScreenView load from UIC as an unresponsive state.

Display Name
Unresponsive Gestures [BB]

Internal Name
CUST.E_UNRESPONSIVE_GESTURES_BB

Advanced Mode
true

Description
Detect root ScreenView load from UIC as an unresponsive state

ImageSrc
default.gif

DisplayInPortal
false

DisplayInSessionList
false

JavaScript: (Advanced Mode only)
function CUST$E_UNRESPONSIVE_GESTURES_BB()
{

var ugDetected = false;
var offsetThreshold = 100; //in ms

//Detect root ScreenView load from UIC as an unresponsive state
//Event offset in UIC reset on each page so it is unreliable
//when the page changes
if($P["TL.STEP_SCREENVIEW_TYPE"].firstValue().toUpperCase() == "LOAD"

&& $P["TL.STEP_SCREENVIEW_NAME"].firstValue().toUpperCase() == "ROOT")
{

ugDetected = true;
$F.setFact("TL.F_E_LAST_GESTURE_OFFSET_BB", "-1");
$F.setFact("TL.F_E_LAST_GESTURE_BB", "");

}
else
{

if($P["TL.STEP_MESSAGE_TYPE"].patternFound() && $P["TL.STEP_
OFFSET"].patternFound())

{
var lastGestureOffset = $F.factCount("TL.F_E_LAST_GESTURE_

OFFSET_BB") > 0 ? parseInt($F.getLastFact("TL.F_E_LAST_
GESTURE_OFFSET_BB").Value) : -1;

var lastGestureType = $F.factCount("TL.F_E_LAST_
GESTURE_BB") > 0 ? $F.getLastFact("TL.F_E_LAST_
GESTURE_BB").Value : "";

var messageType = $P["TL.STEP_MESSAGE_TYPE"].firstValue();
var offset = parseInt($P["TL.STEP_OFFSET"].firstValue());
var tooLong = lastGestureOffset != -1 && (offset - lastGestureOffset)

>= offsetThreshold;
var isExpectedMessageType = false;

//Detect unresponsive gesture (gesture not followed by the
expected type within the threshold [default 100ms])

if(lastGestureOffset != -1)
{

switch(lastGestureType)
{

case "pinch":
isExpectedMessageType = messageType == "1";
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break;
case "swipe":

isExpectedMessageType = messageType == "1" || messageType
== "2";

break;
case "tap":
case "doubleTap":
case "tapHold":
default:

isExpectedMessageType = messageType == "4";
break;

}

ugDetected = !isExpectedMessageType && tooLong;
}

//If we see a gesture, track its timestamp for the next call of
this event

if(messageType == "11")
{

lastGestureOffset = offset;
if($P["TL.P_SESSIONS_0_MESSAGE_STEP_ENTRY_IN_REQUEST"].

patternFound())
$F.setFact("TL.F_E_LAST_GESTURE_BB", $P["TL.P_SESSIONS_

0_MESSAGE_STEP_ENTRY_IN_REQUEST"].firstValue());
else

$F.setFact("TL.F_E_LAST_GESTURE_BB", "");
}
else

$F.setFact("TL.F_E_LAST_GESTURE_OFFSET_BB", "-1");
}

}

if (ugDetected)
$F.setFact("CUST.F_E_UNRESPONSIVE_GESTURES_BB", "TLT$NULL");

}

Define mobile browser-based session events with the Event Manager
Through the Tealeaf Event Manager, you can define events that apply only to
mobile browser-based sessions.

By including this condition in your event definition, the event is triggered only for
mobile browser sessions:

In the example event, the initial condition is set to test for the Browser Traffic
Type session agent that is equal to MOBILE. This event tests for all conditions to
be true for the event to fire. You can add other conditions to the event to create
events that apply to mobile-only sessions.

For each event that you create for mobile browsers, you must add the session
agent as a test condition to restrict the test to only mobile-sourced sessions.

Figure 7. Session attribute Browser Traffic Type as event condition
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For more information about editing events, see "TEM Events Tab" in the IBM
Tealeaf Event Manager Manual.

Use the Traffic Type dimension to identify sessions from
self-reporting browsers

You can use the provided Traffic Type dimension to filter your reports to display
only information from sessions that are sourced from self-reporting mobile
browsers.

When the Traffic Type dimension is added to the report, you can filter the
dimension to display one of the following values to report on events and ratios for
mobile web or mobile native application sessions.

Traffic Type Dimension Value Description

MOBILE Session was initiated from a mobile web
browser and was captured by IBM Tealeaf
CX UI Capture j2.

See "Integrating Client Framework Data into
Tealeaf" in the IBM Tealeaf Client Framework
Data Integration Guide.

MOBILE_APP Session was initiated from a mobile native
application and was captured by a Tealeaf
client framework.

See "Integrating Client Framework Data into
Tealeaf" in the IBM Tealeaf Client Framework
Data Integration Guide.

For more information about creating reports with the Traffic Type dimension, see
"Tealeaf Report Builder" in the IBM Tealeaf Reporting Guide.

The Traffic Type dimension is sourced from the same information on the request
as the Browser Traffic Type session attribute.
v See "TEM Dimensions Tab" in the IBM Tealeaf Event Manager Manual.

Creating mobile events based on data for the device
You can create other events that are based on the mobile data for the device, as
extracted from the WURFL standard. Since this information is stored in the request
record, you can create a hit attribute to look for values for each of the request
variables listed. Then, you can create events or dimensions that use these hit
attributes as source data
1. Create hit attribute:

a. In the Portal, select Configure > Event Manager.
b. Click the Hit Attributes tab. See "TEM Hit Attributes Tab" in the IBM Tealeaf

Event Manager Manual.
c. Click New Hit Attribute.
d. Specify the hit attribute properties:

1) You can name it similar to the request variable for easy identification.
2) Search in: Request
3) Use Start Tag/End Tag: selected
4) Start Tag: Use the following request variable and an equal sign as in the:
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TLT_TRAFFIC_TYPE=

5) End Tag: Use the following string:
\r\n

e. Click Save Draft.
f. Click Save Changes.

2. Create event:
a. In the Portal, select Configure > Event Manager.
b. Click the Events tab. See "TEM Events Tab" in the IBM Tealeaf Event Manager

Manual.
c. Click New Event.
d. Specify the hit attribute properties:

1) You can name it similar to the request variable for easy identification.
2) For the Condition, click the Hit Attributes tab. Select the hit attribute

that you created. Specify the conditions as needed for the event.
3) For the Value, click the Hit Attributes tab. Select the hit attribute that

you created. You specify that the event is configured to record the value
of the hit attribute.

4) Make other configuration changes as needed.
e. Click Save Draft.
f. Click Save Changes.

3. Repeat the previous steps for any of the mobile hit attributes that you like to
capture in events.

Dimension value lists
You can enable logging on dimensions to collect lists of data. You can modify the
data set and reuse it in dimension reports.

To support the set of lists, you can enable logging on the dimensions you create to
gather data. This data can then be downloaded through the Event Manager to your
local system, where you can normalize the data and add or remove values. This
list of values can then be reloaded into the dimension as a whitelist.
v For more information about generating these lists, see "User Agent Tools" in the

IBM Tealeaf cxImpact Administration Manual

Mobile event reports
When the events are enabled, instances of event data can be counted, or the data
values can be broken out for reporting.

Through the Tealeaf Portal, you can create analysis of events. Through the Tealeaf
Portal, select Analyze > Report Builder. The list of available menu options are
displayed.

For more information about individual reports for IBM Tealeaf CX Mobile, see
Chapter 5, “Generate reports for Mobile web,” on page 57.

Average Session Size and Length by Platform report
This report shows the average session size in MB per mobile session count and the
average mobile session length in seconds per session count. Data is filtered by
platform.
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This table lists and describes the information in this report:

Value Description

Platform The mobile platform that the application is
running on. Valid values are:

v iOS

v Android

Mobile Session Size (MB) per Mobile Session
Count

The ratio of session size, in MB, to session
count for the Mobile platform.

Mobile Session Length (sec) per Mobile
Session Count

The ratio of session length, in seconds, to
session count for the Mobile platform.

Exceptions By Day And Platform Report
This report shows the number of exceptions for a Mobile application. the data is
filtered by day and by platform. The report also provides an hourly average of
exceptions.

This table lists and describes the information in this report:

Value Description

Day The current day.

Totals The total number of exceptions logged on
the platform on the current day.

Hourly Average The average number of exceptions that are
received in an hour.

Platform The mobile platform that the application is
running on. Valid values are:

v iOS

v Android

v Hybrid

Exceptions by ScreenView report
This report shows the exceptions for a Mobile application. Data is filtered by
ScreenView.

This table lists and describes the information in this report:

Value Description

Step - ScreenView The ScreenView that had the exception.

Count The number of exceptions that occurred on
the ScreenView.

Percentage of Sessions with Exceptions report
This report shows the percentage of Mobile application sessions that had
exceptions.

This table lists and describes the information in this report:
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Value Description

Day of Month The current date.

Session with at least one exception per
Mobile Session

The number of mobile sessions that had at
least one exception

Percentage of sessions with exceptions The percentage of mobile sessions that had
at least one exception out of all of the
sessions that had at least one exception.

Resizes by ScreenView report
This report shows the number of Mobile sessions that logged resize gestures. Data
is filtered by ScreenView.

This table lists and describes the information in this report:

Value Description

Step - ScreenView The ScreenView that had the resize gesture.

Count The number of resize gestures logged on the
ScreenView

Totals The total number of rezise gestures for the
ScreenView.

Hourly Average The average number of resize gestures
received in an hour for the ScreenView.

Session Count by Date report
This report shows the number of Mobile sessions that are logged by date.

This table lists and describes the information in this report:

Value Description

Day The current date.

Count The number of mobile sessions.

Totals The total number of mobile sessions for the
current date.

Hourly Average The average number mobile in an hour.

Session Count by Day and Carrier report
This report shows the number of Mobile sessions logged by date. Data is filtered
by mobile carrier.

This table lists and describes the information in this report:

Value Description

Day The current day.

Totals The total number of sessions for a carrier on
the current day.

Hourly Average The average number of sessions logged for
the carrier in an hour.
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Value Description

Carrier The mobile carrier that the application is
running on. Valid values are:

v ?

v ?

v ?

Session Count by Hour report
This report shows the number of mobile sessions that are counted by hour. The
report also provides an average of session counts for the previous four days of the
week as the current report.

This table lists and describes the information in this report:

Value Description

Hour of the day The hour of the current day.

Mobile Session Count The number of mobile sessions for the hour.

Mobile Session Count [Count - 4 Same DoW
Avg]

The average number of sessions for the same
hour for the last for same days of the week.

Session Count by OS Version report
This report shows the number of Mobile sessions counted. Data is filtered by OS
version.

This table lists and describes the information in this report:

Value Description

Hour of the Day The hour of the day.

Step - OS Version The OS version for the session.

Mobile Session Count The number of mobile sessions for the OS
version for the hour.

Session Count by Platform report
This report shows the number of Mobile sessions per hour for the current day.
Data is filtered by platform.

This table lists and describes the information in this report:

Value Description

Hour of the Day The hour of the day.

Platform The platform for the session. Valid values
are:

v iOS

v Android

v UIC

Mobile Session Count The number of mobile sessions for the
platform for the hour.
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Unresponsive Gesture Struggles by ScreenView report
This report shows the number of unresponsive Mobile gesture struggles. Data is
filtered by ScreenView.

This table lists and describes the information in this report:

Value Description

Step - ScreenView The ScreenView on which the unresponsive
gesture struggle was logged.

Unresponsive Gestures Count The number of unresponsive gesture
struggles for the ScreenView.

Unresponsive Gesture Struggles by Day and Platform report
This report shows the number of Mobile gesture struggles. Data is filtered by day
and platform.

This table lists and describes the information in this report:

Value Description

Hour of the Day The hour of the day.

Platform The platform for the session. Valid values
are:

v iOS

v Android

v UIC

Unresponsive Gestures The number of unresponsive gestures for the
platform for the hour.
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Chapter 5. Generate reports for Mobile web

With the ability to filter analysis based on the type of device, you can generate
reports on mobile devices. These mobile devices are used to access the monitored
web application. This information applies to sessions initiated through mobile web
browsers to your web application.

For example, suppose that you are able to identify mobile users by device type.
Through Tealeaf reporting, you discover that mobile users are predominantly
creating one-page sessions, meaning that they view a single page on your website
before leave. Which pages are viewed the most by mobile visitors in one-page
sessions: login, status update, or other?
v If mobile visitors are hitting only the login page, perhaps there are functional

problems with the page that are preventing mobile users from accessing the site.
v If visitors are hitting a status update page, then content to that page can be

tailored for maximal effect for mobile users with more links to useful pages
deeper in the site.

Tealeaf CX Mobile Dashboard
The IBM Tealeaf CX Mobile module includes the Mobile Traffic Dashboard, which
must be imported into your Tealeaf solution.

Build Your Own Reports
Based on the reference data for mobile devices and the events that are created to
monitor them, you can create event-based reports to identify mobile activities. In
the Tealeaf Report Builder, you can create reports that are filtered by the Traffic
Type dimension, which can be used to identify sessions that are initiated from a
mobile browsing device.

Traffic Type Dimension Value Description

MOBILE Session was initiated from a mobile web
browser and was captured by IBM Tealeaf
CX UI Capture for AJAX.

See "Integrating Client Framework Data into
Tealeaf" in the IBM Tealeaf Client Framework
Data Integration Guide.

MOBILE_APP Session was initiated from a mobile native
application and was captured by a Tealeaf
client framework.

See "Integrating Client Framework Data into
Tealeaf" in the IBM Tealeaf Client Framework
Data Integration Guide.

For more information about creating reports with the Traffic Type dimension, see
"Tealeaf Report Builder" in the IBM Tealeaf Reporting Guide.

These reports can then be integrated as components in custom dashboards.
v See "Configuring Dashboards" in the IBM Tealeaf cxView User Manual.
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Chapter 6. Generate reports for Mobile App

The IBM Tealeaf Mobile App logging frameworks enable the capture of a large
array of device properties and user interface events into Tealeaf, where these
values can be made available for reporting. Using data that is sourced from the
Tealeaf Logging Frameworks, you can create event objects, such as hit attributes,
dimensions, and events, to capture this data for reporting purposes. When the
objects are created, you can use them in the same reports that are described at the
end of section. You can also use them in reports that are already created.

Use of the Tealeaf Logging Frameworks for mobile native applications requires the
Tealeaf CX Mobile license for Mobile App. For more information, contact your
Tealeaf representative.
Licensees must implement in their apps code that is provided by Tealeaf. For more
information on downloading Tealeaf software, see Tealeaf CX Downloads.

Pre-requisites for Mobile application reports
IBM Tealeaf CX Mobile for Mobile App uses one or more Tealeaf Logging
Frameworks, which must be deployed and configured with the mobile native
applications deployed to your visitors. YOu must download and deploy these
frameworks before you can report on mobile applications.
v See the IBM Tealeaf iOS Logging Framework Guide.
v See the IBM Tealeaf Android Logging Framework Guide.

Two data transmission methods
The Tealeaf Logging Frameworks support two methods of submitting data and
capturing it in Tealeaf.

This table lists and describes the data transmission methods:

Table 5. Two data transmission methods

Method Supported Releases Description

Hit-
splitting

Release 8.4 If you implemented a Tealeaf logging framework
to interact with your Release 8.4 system, you
must deploy a session agent in your Windows
pipeline. This session agent splits captured
messages into individual hits, which are inserted
into the regular session data.

This legacy method of processing client
framework is supported in the current release. In
a future release, it is likely to be deprecated.

v For more information on this session agent, see
"JSON Mobile Parser Session Agent" in the
IBM Tealeaf CX Configuration Manual.
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Table 5. Two data transmission methods (continued)

Method Supported Releases Description

Step-based
eventing

Release 8.5 and later The logging frameworks submit messages in a
unified JSON format. These messages are
inserted into the request, from which you can
create attributes and events.

v For more information on step-based eventing,
see "Step-Based Eventing" in the IBM Tealeaf
Event Manager Manual.

Configure Event Objects
Tealeaf provides a set of step attributes and events to support the tracking of user
interface events that are captured through a Tealeaf client framework. These objects
can be used as the basis for building other event objects for tracking the specifics
of your client application.

For more information about the provided event objects and other objects of value
to create, see "Integrating Client Framework Data into Tealeaf" in the IBM Tealeaf
Client Framework Data Integration Guide.

Report data
You create attributes, events, and dimensions to track mobile native application
events and data. You use the attributes, events, and dimensions to build reports.
Or you can use objects in reports that you already created in the Tealeaf Report
Builder.

Dimensions and events

For tracking purposes, dimensions, such as the Mobile Device dimension, must be
associated with events before dimensional data can be recorded for the events. By
default, this dimension is associated with some Tealeaf Standard Events. Before
you track event activities by mobile device type, this dimension must be associated
with those events first, and event instances must be detected and recorded. See
"TEM Events Tab" in the IBM Tealeaf Event Manager Manual.

For more information about creating reports, see "Tealeaf Report Builder" in the
IBM Tealeaf Reporting Guide.

Track Variations

For events captured from mobile native applications, you might want to track
variations in reported values. For example, you want to identify changes in
reported hit counts for the mobile native applications, which might signal
disinterest with the application.

Through the Event Manager, you can create Top Movers to track variations in
reported values for specific events or dimensions. These Top Movers can be
configured to be calculated on hourly or daily intervals.
v For more information about creating Top Movers, see "TEM Top Movers Tab" in

the IBM Tealeaf Event Manager Manual.
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When Top Movers are created and capturing data, you can create and review
reports on Top Movers through the Portal. These easy-to-use reports provide a
basic mechanism for tracking variations in captured values on key metrics that are
related to application health. You can display multiple Top Movers of your mobile
native application data to monitor basic changes in customer interactions with it.

Note: Some components of Top Movers reporting are available with the IBM
Tealeaf cxView license. See "Enhancements to Top Movers for cxView" in the IBM
Tealeaf cxView User Manual.

For more information about creating Top Movers reports, see "Analyzing Top
Movers" in the IBM Tealeaf Reporting Guide.

Drill-down search for data

From either Top Mover or Report Builder reports, you can drill into the report to
explore individual sessions. From the:
v Top Mover report, use links in the data table to open the Tealeaf Report Builder

with a report on the underlying event or dimension that is displayed by using
the appropriate date range.

v Report Builder report, you can use the links in the data table to open a session
list. It contains the sessions that are supporting the data reported in the link you
clicked.

From the session list, you can explore individual sessions, including locating the
exact hit where the event or dimension was recorded.
v See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Portal search

You can also search sessions that are containing individual events or event +
dimension combinations through the Portal.
v See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Available Dashboards
Tealeaf provides report templates and dashboards that you can download and
install in your Tealeaf solution.
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Chapter 7. IBM Tealeaf documentation and help

IBM Tealeaf provides documentation and help for users, developers, and
administrators.

Viewing product documentation

All IBM Tealeaf product documentation is available at the following website:

https://tealeaf.support.ibmcloud.com/

Use the information in the following table to view the product documentation for
IBM Tealeaf:

Table 6. Getting help

To view... Do this...

Product documentation On the IBM Tealeaf portal, go to ? > Product
Documentation.

Help for a page on the IBM Tealeaf Portal On the IBM Tealeaf portal, go to ? > Help
for This Page.

Help for IBM Tealeaf CX PCA On the IBM Tealeaf CX PCA web interface,
select Guide to access the IBM Tealeaf CX
PCA Manual.

Available documents for IBM Tealeaf products

Use the following table to view a list of available documents for all IBM Tealeaf
products:

Table 7. Available documentation for IBM Tealeaf products

IBM Tealeaf products Available documents

IBM Tealeaf CX v IBM Tealeaf Customer Experience Overview
Guide

v IBM Tealeaf CX Client Framework Data
Integration Guide

v IBM Tealeaf CX Configuration Manual

v IBM Tealeaf CX Cookie Injector Manual

v IBM Tealeaf CX Databases Guide

v IBM Tealeaf CX Event Manager Manual

v IBM Tealeaf CX Glossary

v IBM Tealeaf CX Installation Manual

v IBM Tealeaf CX PCA Manual

v IBM Tealeaf CX PCA Release Notes

© Copyright IBM Corp. 1999, 2014 63

https://tealeaf.support.ibmcloud.com/


Table 7. Available documentation for IBM Tealeaf products (continued)

IBM Tealeaf products Available documents

IBM Tealeaf CX v IBM Tealeaf CX RealiTea Viewer Client Side
Capture Manual

v IBM Tealeaf CX RealiTea Viewer User
Manual

v IBM Tealeaf CX Release Notes

v IBM Tealeaf CX Release Upgrade Manual

v IBM Tealeaf CX Support Troubleshooting
FAQ

v IBM Tealeaf CX Troubleshooting Guide

v IBM Tealeaf CX UI Capture j2 Guide

v IBM Tealeaf CX UI Capture j2 Release Notes

IBM Tealeaf cxImpact v IBM Tealeaf cxImpact Administration Manual

v IBM Tealeaf cxImpact User Manual

v IBM Tealeaf cxImpact Reporting Guide

IBM Tealeaf cxConnect v IBM Tealeaf cxConnect for Data Analysis
Administration Manual

v IBM Tealeaf cxConnect for Voice of Customer
Administration Manual

v IBM Tealeaf cxConnect for Web Analytics
Administration Manual

IBM Tealeaf cxOverstat IBM Tealeaf cxOverstat User Manual

IBM Tealeaf cxReveal v IBM Tealeaf cxReveal Administration Manual

v IBM Tealeaf cxReveal API Guide

v IBM Tealeaf cxReveal User Manual

IBM Tealeaf cxVerify IBM Tealeaf cxVerify Administration Manual

IBM Tealeaf cxView IBM Tealeaf cxView User Manual

IBM Tealeaf CX Mobile v IBM Tealeaf CX Mobile Android Logging
Framework Guide

v IBM Tealeaf Android Logging Framework
Release Notes

v IBM Tealeaf CX Mobile Administration
Manual

v IBM Tealeaf CX Mobile User Manual

v IBM Tealeaf CX Mobile iOS Logging
Framework Guide

v IBM Tealeaf iOS Logging Framework Release
Notes
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Bay Area Lab
1001 E Hillsdale Boulevard
Foster City, California 94404
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
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programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.

Privacy Policy Considerations
IBM Software products, including software as a service solutions, ("Software
Offerings") may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that
identifies your computer. In many cases, no personal information is collected by
these cookies. If a Software Offering you are using enables you to collect personal
information through cookies and similar technologies, we inform you about the
specifics below.

Depending upon the configurations deployed, this Software Offering may use
session and persistent cookies that collect each user's user name, and other
personal information for purposes of session management, enhanced user usability,
or other usage tracking or functional purposes. These cookies can be disabled, but
disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through
cookies and similar technologies. If the configurations deployed for this Software
Offering provide you as customer the ability to collect personal information from
end users via cookies and other technologies, you should seek your own legal
advice about any laws applicable to such data collection, including any
requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer's
website terms of use (e.g. privacy policy) which includes a link to IBM's and
Client's data collection and use practices, (2) notify that cookies and clear gifs/web
beacons are being placed on the visitor's computer by IBM on the Client's behalf
along with an explanation of the purpose of such technology, and (3) to the extent
required by law, obtain consent from website visitors prior to the placement of
cookies and clear gifs/web beacons placed by Client or IBM on Client's behalf on
website visitor's devices

For more information about the use of various technologies, including cookies, for
these purposes, See IBM's Online Privacy Statement at: http://www.ibm.com/
privacy/details/us/en section entitled "Cookies, Web Beacons and Other
Technologies."
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